
 

 
 Titan V6 Full Upgrade Guide   V1.6   August 7th 2012               - 1 - 

 

 
 

Titan V6 Upgrade Guide 

For Tiger Touch, Pearl Expert and 
ShowSafe 

 

www.avolites.com/V6Upgrade 

 Version 1.6 

This document, the product and procedures it describes within are 
intellectual property of Avolites Ltd. at all times. 

 

Useful Avolites phone numbers:- 

Avolites England 

Sales and service* (+44) (0) 20 8965 8522 

Service out of hours* (+44) (0) 831 17 8888 

Fax   (+44) (0) 20 8965 0290 

Email   service@avolites.com 

Website    http://www.avolites.com 

 

The small print: 

No Liability for Consequential Damages 

Avolites has a policy of continuous product and documentation improvement. As such the detail within 
this manual may not match the operation of the Tiger Touch, Pearl Expert and Expert ShowSafe. 

In no event shall Avolites be liable for any direct, indirect, special, incidental, or consequential 
damages or loss whatsoever (including, without limitation, damages for loss of profits, business 
interruption, or other pecuniary loss) arising out of the use or inability to use Tiger Touch, Pearl Expert 
and Expert ShowSafe even if Avolites Ltd. has been advised of the possibility of such damages. 
Because some jurisdictions do not allow the exclusion or limitation of liability for consequential or 
incidental damages, the above limitation may not apply to you. 

 

Reprint and revision history: 

First produced June 2012 By Gareth /JB Avolites Ltd 
V1.2 24/07/2012 edits RS/OW/JB PE screen turn 

V1.3 DWR contributions added V1.4 Spinners added JBT 
V1.5 Bios stick creation change 31/07/12 JBT/GH 
V1.6 Floppy update appendix added 07/08/12 TR 

http://www.avolites.com/V6Upgrade
mailto:name@avolites.com
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1. Introduction 

This document is a step by step guide on how to prepare a Tiger Touch, 

Pearl Expert and Expert Show Safe for Titan Version 6 and install Titan V6 

on the console. 

During this update you will perform the following updates depending on the 

console: 

 Clean the CPU fan 

 Apply ECN (for some Tiger touch consoles only) 

 Identify what drive is fitted  

 Update the SSD drive firmware if applicable 

 Update the BIOS 

 Install V6 

 Run a HealthCheck on the console  

 Update the Recovery stick inside the console 

The guide applies to the following products: 

Tiger Touch, Pearl Expert, Expert ShowSafe 

It is vital that the steps including the various checks are followed in the 

correct order and manor to assure that the installation is correct. Failure to 

do this may decrease the reliability of your console. 

The upgrade and installation takes a little over 90 minutes for the fist 

console and about 60 minutes for subsequent ones (assuming files have 

been downloaded and no ECN needs applying), you should allow half an 

hour on top of this to read and familiarise yourself with what needs to be 

done. Please follow the instructions in the order specified here.  

The V6 installation will wipe the internal drive and therefore all the user 

files need to be backed up before you start on this upgrade. 

Allow enough time for complications, this is a major upgrade and it is 

always possible something will need extra time. We suggest that the 

upgrade is carried out during UK office hours so you can contact us should 

you need to. 

We have placed a strong support system for this upgrade here at Avolites, 

which can be reached by phone (UK office hours) and by email. The 

phone numbers can be found on the second page of this document. 

Please contact us in case of doubt rather than to carry on, our wish is that 

the upgrade is successful and we are here to help you. 

Alternatively we will carry out the upgrade at Avolites free of charge; this 

can usually be carried out on the same day providing it is booked in 

advance. 

Outside of the UK, contact you local reseller about their upgrade service.  

We strongly suggest you print this document and use it as a reference 

guide as you work through the upgrade. 

Please note that section 15 has some common problems explained   
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1.1 What you need 

 Four USB stick between of at least 2Gb capacity each 

 Windows Computer with a free USB port where you have administrator 

rights (preferably Vista or Windows 7) and access to the internet. 

 External VGA monitor 

 USB or PS2 keyboard (for Tiger Touch and ShowSafe only) 

 ECN-193 Pn:8002-9193 components (for some consoles only) 

 At least 90 minutes of your time for the first console , and then about 60 

for subsequent consoles 

 No. 2 Pozi drive and a T20 Torx screwdriver 

 Small flat-blade screw driver 

 Vacuum cleaner 

Important note on USB sticks 
 

Not every USB stick is capable to boot from, we have tested Integral, HP and 
Corsair to work. Transcend, Verbatim “Store “n” Go” and Cruzer tend not to work. 

1.2 What you get – background information  

Avolites Titan V6 is a major release which has many new features and 

reliability improvements that require other components in the console 

to be updated as well.  

Over a 6 months period Avolites has worked with various component 

suppliers to upgrade firmware and BIOS firmware to resolve occasional 

failures found in our test program and reported in the field. Some tests 

involved power cycling a pool of consoles every 2 minutes for weeks, or 

interrupting the mains supply while the drive was accessed 10,000 

times. The BIOS in particular has been extensively tested to verify it 

improved the USB resilience. Additionally parts of the operating system 

have been upgraded to increase reliability. 

As part of Titan V6 install the Hard Disk will now retain information 

between upgrades making future upgrades easier, and the whole 

restore process is generally faster. 

1.3 WARNING 

Before you start, make sure that the show files 
are backed up away from the console. During this 
upgrade the console drive will be erased.  

This update manual assumes you connect an 
external screen and Keyboard to the Tiger Touch and Expert 
ShowSafe, not doing so will make it harder to support you. 
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1.4 Internet Connection 

We are assuming you have a reasonably fast internet connection. If you 

have a slow connection you may decide to download and create the 

required USB pens before starting the upgrade. In which case download 

the following files onto separate USB sticks (and mark the USB stick with 

appropriately!) 

www.avolites.com/V6Upgrade 

BIOS Upgrader:  see section 4.1 

OCZ Solid 2 Firmware: see section 7.1 

OCZ Vertex 2 Firmware: see section 6.1 

Titan Version 6, appropriate to your console: Tiger Touch or Expert. 

    See section 12.2 

 

1.5 What processes need to be followed 

There are many steps to follow and a number of them depend on what 

hardware is inside the console, therefore follow the matrix and mark which 

steps you have done to guide you thought the process.  

Please note that there is only one choice of drive in a console, if the drive 

fitted is not listed below contact Avolites for support. 

An example of how to use the process checklist: 

 

http://www.avolites.com/V6Upgrade
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Hint; Take this page out and use as checklist next to console 

 

Process checklist 

Process: Applies to Relevant 

Yes/No 

Document 
section 

Completed 

Show and log file backup All units Yes  2 [    ] 

Open console and clean Fan All units Yes  3 [    ] 

Update Bios All Units Yes  4 [    ] 

Identify Hard Disk type 
installed in console 

All units Yes  5  

If OCZ Vertex 2 fitted [      ]  6 [    ] 

If OCZ Solid 2 fitted [      ]  7 [    ] 

If Intel 320 fitted [      ]  8 HealthCheck 

If Intel 330 fitted [      ]  9 No action 

If  Fujitsu, Toshiba, or 
Hitachi fitted 

[      ]  9 No action 

ECN-193 (Tiger Touch only) TT Sn. 899-968 only [      ]  10 [    ] 

ECN-194 (Pearl Expert only) PE Sn.1445-1650 only [      ]  11 [    ] 

Install Titan V6 All Units Yes  12 [    ] 

Follow any on screen 
feedback from Titan 
HealthCheck 

All Units Yes  13 [    ] 

Intel 320 updated with Titan HealthCheck [    ] 

Fit Recovery stick into 
console 

All Units Yes  14 [    ] 

This concludes the full Titan V6 upgrade… 

Thanks and congratulations from the Avolites team 
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2. Show file and Log file backup 

Before proceeding with this update, you should make a back-up of your 

shows stored on the internal drive. Although the firmware update should 

leave the drive data intact, if anything goes wrong during the update (e.g. 

an unexpected power outage) you could lose the data on the drive.   

A- Save your shows on a USB stick (not the one used to upgrade with)  

B- Run the Log collector from the “Tools” menu 

Mark this process as Completed in the Process checklist above  

 

 

This concludes section 2. Follow the Process Checklist. 

 

3. Open console and clean Fan 

3.1 Open the Tiger Touch 

Switch off the console and disconnect from the mains and other 

networks 

Open the console by removing the three screws at the front edge of the 

console, these screws may be No.2 Pozi drive or T20 Torx, lift the front and 

hook the stand on the right side of the console to the moulding fixing.  

Open the Pearl Expert 

Switch off the console and disconnect from the mains and other 

networks 

Open the console by twisting the 4 DZUS screws ¼ turn anti-clockwise and 

then lifting the panel all the way up 

3.2 Clean the CPU fan 

Using your finger or a small flat bladed screwdriver carefully stop the CPU 

fan from spinning whilst cleaning the CPU fan with the vacuum cleaner 

Mark this process as Completed in the Process checklist above  

 

This concludes section 3. Follow the Process Checklist.  
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4. Updating the Bios firmware 

4.1 Creating BIOS bootable USB stick 

Download the BIOS update tool from the Avolites Titan V6 upgrade landing 

page: www.avolites.com/V6Upgrade 

A- Insert the blank USB stick in your PC or Laptop. 

B- Double click on the downloaded “Avolites BIOS Update Creator.exe” file. 

This will open a new window with a brief copy of these instructions.  

Note: Windows may warn you about running the application as an 

Administrator or that it is from an “Unknown Publisher”, in either 

case select “Run” or “Yes” to continue. 

C- Click on “Next” in the Avolites application. 

D- Select the USB stick from the Drives pull down menu. 

E- Click on “Install”, a new window with a progress bar is shown during 

the creation of the stick data. 

F- Click on “Next” in the Avolites application once upgrade stick creation is 

finished this will show a brief instruction on the BIOS upgrade process.  

G- Click on “Close” to end the Avolites application. 

H- Ensure that the USB stick is safely ejected and removed from the PC. 

Note: Please note that the BIOS upgrade USB stick made above can be 

used on multiple consoles.  

4.2 Installing the new BIOS into the console 

 

1. Plug in an external VGA monitor to the console  

2. Plug in an external keyboard in the Tiger Touch & Expert ShowSafe 

3. Connect the BIOS USB stick in one of the USB ports at the back of the 

desk. 

4. Start-up the console and press [Delete] on the keyboard.  

5. When prompted, type in the password “68340” followed by [Enter], to 

access the BIOS.  

6. Once in the BIOS, use the arrow keys to select the “Advanced BIOS 

Features” menu and enter to open this.  

7. Then use the arrow keys to select the “Hard Disk Boot Priority” menu and 

[Enter]. 

8. Use the [PgUP] key to move the USB drive in position 1. (top line)  

9. Press [F10] then [Y] followed by [Enter] to save the BIOS settings and re-

boot. 

10. When the console restarts it will boot automatically into the memory stick 

and BIOS updater. 

11. Once the memory stick has booted it will ask if you wish to “Program”, 

press the [Y] key. The BIOS will now be updated, during this time do not 

power down. 

http://www.avolites.com/V6Upgrade
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12. After the BIOS update is done the computer will try to boot, and then fail 

on the first BIOS screen with a floppy seek error, this is intentional; At this 

point shut down the console using the Power button on the front and 

remove the USB stick. 

4.3 Configuring the new BIOS 

The next steps are required to correctly configure the new BIOS. An 

external screen will be required. 

PLEASE TAKE EXTREME CARE TO CONFIGURE THE BIOS 

CORRECTLY. FAILURE TO DO THIS WILL REDUCE THE 

RELIABILITY OF THE CONSOLE. 

Note: The Pearl Expert and the Tiger touch have different settings in some 

of the fields, these settings are presented in a table form below 

1. Start-up console and enter the BIOS again by pressing the [Delete] Key.  

2. Once in the BIOS, use the arrow keys to select the “Load Optimized 

Defaults” menu then press [Enter] followed by [Y] and then press [Enter] 

to confirm. 

3. Use the arrow keys to select the “Set Supervisor Password” menu and 

press [Enter], type in “68340” when prompted followed by [Enter] then 

confirm the password and press [Enter] 

4. Use the arrow keys to select the “Set User Password” menu and press 

[Enter] , type in “68340” when prompted followed by [Enter] then confirm 

the password and press [Enter] 

5. Use the arrow keys to select the “Standard CMOS Features” Menu and 

press [Enter] 

6. Set the correct “Date and Time”,  

7. Set “Drive A” to: None,  

8. Set “Halt on” to: All, But Keyboard   

9. Press Exit then Select “Advanced BIOS features”  

10. Set the “First Boot Device” to: USB Device 

11. Set the “Second Boot Device” to: Disabled 

12. Set the “Third Boot Device” to: Disabled 

13. Set the “Boot Other Device” to: Disabled 

14. Set “Swap Floppy Drive” to: Disabled 

15. Set “Boot Up Floppy Seek” to: Disabled 

16. Set “Boot Up NumLock Status” to: Off 

17. Press [Esc] then Use the arrow keys to select the “Advanced Chipset 

Settings” Menu and press [Enter] 

18. Set the “PEG/Onchip VGA Control” to: Auto 

 

19.   

 

 

20. Set the “LCD Type” to: 7 

21. Press [Esc] then enter the “Integrated Peripherals” Menu, and then 

enter the “Onboard Device” Menu. 

22. Set the “USB Keyboard Support” to: Enabled, then press [Esc] to get 

back to the previous menu. 
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23. In the “Integrated Peripherals” Menu, use the arrow keys to select 

“Super IO Device” Menu, and the press [Enter]. 

24. Set the “PWRON After PWR-Fail” to: Former-Sts 

25. Press the [F10] button and then [Enter] to save the changes, the console 

will attempt to re-boot. An error will appear saying there is no system disk, 

at this point shutdown the console using the soft power button on the left 

hand side. 

Mark this process as Completed in the Process checklist above  

 

This concludes section 4. Follow the Process Checklist. 
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5. Identifying the Hard Disk Drive type  

During the years of production Avolites has fitted a number of drives 

brands and types. There are different upgrades for different drive types. In 

order to select the correct upgrade procedure identify which drive is fitted 

in the console and mark it in the Process checklist above.  

Note: Only one drive type can be selected. 

Note: If the drive fitted is not listed in the Process Checklist contact 

Avolites for support 

Example of checklist when a Solid 2 is fitted 

 

In the console locate the Drive (follow the RED SATA cable) 

Identify which drive you have fitted and mark in the process checklist 

  
  

Intel 330 Hitachi  Fujitsu Toshiba 

 spinning disks no action required 

 Continued on the next page 

 
  

Intel 320 OCZ Solid 2 

(Red label) 

OCZ Vertex 2  

(Black label) 

 

Mark this process as done by selecting one drive type in the Process checklist 
above  

This concludes section 5. Follow the Process Checklist. 
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6. OCZ Vertex 2 SSD fitted, update procedure 

6.1 Creating the OCZ Vertex 2 bootable USB stick 

Download the OCZ Vertex 2 Update creator file from the Avolites Titan 

Version 6 upgrade landing page www.avolites.com/V6Upgrade onto your 

PC. 

I- Insert the blank USB stick in your PC or Laptop 

J- Open the downloaded Zip file and double click the “Avolites OCZ Vertex 

2 Firmware Update Creator V1.37.exe”file, This will open a new window 

with a brief copy of these instructions.  

Note: Windows may warn you about running the application from a 

compressed folder, select “Run” to continue. You may also get a 

“Unknown Publisher” warning, select “Yes” in this case 

K- Click on “Next” in the Avolites application  

L- Select the USB stick from the  Drives  pull down menu 

M- Click on “Install”, A new window with a progress bar is shown during 

the creation of the stick data, a second window will appear that creates 

the environment on USB stick, No user action is required on this 

window. 

N- Click on “Next” in the Avolites application once upgrade stick creation is 

finished this will show a brief instruction on the firmware upgrade 

process.  

O- Click on “Close” to end the Avolites application and automatically eject 

the USB stick. 

P- Remove the USB stick from the PC. 

Note: Please note that the SSD firmware upgrade USB stick made above 

can be used on multiple consoles if they have the same SSD fitted 

6.2 Upgrading an OCZ Vertex 2 Solid State Drive 

Make sure the console BIOS upgrade is done 

1- Connect the USB stick in one of the USB ports at the back of the desk. 

2- Plug in the External VGA screen 

3- Plug in an external keyboard (Tiger Touch and Expert ShowSafe only) 

4- Start-up the console AND press the [Delete] on the keyboard to enter 

the BIOS.  

5- When prompted, type in the password “68340” followed by [Enter], to 

access the BIOS.  

6- Once in the BIOS, use the arrow keys to select the “Advanced BIOS 

Features” menu and [Enter] to open this. 

7- Check that the “First Boot Device” is set to “USB Device” use the  

8- Press the [F10] then [Y] to save the changes and then [Enter].  

9- When the console restarts it will boot automatically into the memory 

stick and requires no user action. 

10- The updated will first start the “UNetbootin” environment and then 

after 10 seconds the OCZ application 

http://www.avolites.com/V6Upgrade
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11- The firmware will now be updated, and once completed the screen 

should show firmware updated succeeded with a firmware version of 

1.37 in green text 

Note: The screen above will also show a failed message which can be 

ignored 

12- Shut down the console and remove the stick 

Mark this process as done by selecting one drive type in the Process 

checklist above  

 

 

This concludes section 6. Follow the Process Checklist. 
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7. OCZ Solid 2 SSD fitted, update procedure 

The OCS tool can only upgrade one version per cycle, therefore you may be 
required to run this process, follow the instructions below. 

7.1 Creating the bootable USB stick for OCZ Solid 2 Drives 

Download the OCZ Solid 2 Update creator file from the Avolites Titan 

Version 6 upgrade landing page www.avolites.com/V6Upgrade onto your PC. 

A- Insert the blank USB stick in your PC or Laptop 

B- Open the downloaded Zip file and double click the “Avolites OCZ Solid  2 

Firmware Update Creator V170.exe” file, This will open a new window 

with a brief copy of these instructions.  

Note: Windows may warn you about running the application from a 

compressed folder, select “Run” to continue. You may also get a 

“Unknown Publisher” warning, select “Yes” in this case 

C- Click on “Next” in the Avolites application  

D- Select the USB stick from the  Drives  pull down menu 

E- Click on “Install” , A new window with a progress bar is shown during 

the creation of the stick data, a second window will appear that creates 

the environment on USB stick, No user action is required on this 

window. 

F- Click on “Next” in the Avolites application once upgrade stick creation is 

finished this will show a brief instruction on the firmware upgrade 

process.  

G- Click on “Close” to end the Avolites application and automatically eject 

the USB stick. 

H- Remove the USB stick from the PC. 

Note: Please note that the SSD firmware upgrade USB stick made above 

can be used on multiple consoles if they have the same SSD fitted 

 

7.2 Upgrading the OCZ Solid 2 Solid State Drive firmware 

Make sure the console BIOS upgrade is done 

 

The Solid 2drive has been shipped with V1.5 and 1.6 firmware. Titan V6 

requires this to be V1.7. The OCZ upgrade tool can only upgrade one 

version at the time. Therefore the updater may have to be run twice. 

1-  Connect the USB stick in one of the USB ports at the back of the desk. 

2- Plug in the External VGA screen 

3- Plug in an external keyboard (Tiger Touch and Expert ShowSafe only) 

4- Start-up the console AND press the [Delete] on the keyboard to enter 

the BIOS.  

5- When prompted, type in the password “68340” followed by [Enter], to 

access the BIOS.  

http://www.avolites.com/V6Upgrade
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6- Once in the BIOS, use the arrow keys to select the “Advanced BIOS 

Features” menu and [Enter] to open this. 

7- Check that the “First Boot Device” is set to “USB Device” use the  

8- Press the [F10] then [Y] to save the changes and then [Enter].  

9- When the console restarts it will boot automatically into the memory 

stick. 

10- A warning message is displayed, Type [Y] to continue 

11- The firmware will now be updated, and once completed the screen 

should shows a the following line: 

 

“Drive 0: OCZ-SOLID2 SNxxxxxxxx Rev: 1.7” 

then continue to section 7.4 

 

or  

 

Drive 0: OCZ-SOLID2 SNxxxxxxxx Rev: 1.6  

 

12- When the version is 1.6 shut down the console using the power button 

13- Restart the console, the application will start again. 

14- enter [Y] again to continue with the upgrade, once finished the version 

should be: 

“Drive 0: OCZ-SOLID2 SNxxxxxxxx Rev: 1.7” 

continue with section 7.3 

7.3 Solid 2 update conclusion 

Shut down the console and remove the stick 

Mark this process as done by selecting one drive type in the Process 

checklist above  

 

 

This concludes section 7. Follow the Process Checklist. 
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8. Intel 320 SSD fitted, update procedure 

The Intel 320 drive will be updated after Titan V6 is installed using Titan 
HealthCheck, this process does not require a bootable disk . 

Mark this process as done by selecting one drive type in the Process 

checklist above  

 

This concludes section 8. Follow the Process Checklist. 

 

9. Fujitsu, Toshiba or Hitachi Spinning Drive or 
Intel 330 SSD fitted 

No software update is required for these drives 

Mark this process as done by selecting one drive type in the Process 

checklist above. 

  

 

This concludes section 9. Follow the Process Checklist. 
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10. ECN-193 Tiger Touch Inverter Start-up delay 

Tiger Touch consoles with serial number 899 to 968 will need a 

modification to their LCD inverter. For this there is an ECN and parts kit 

available from Avolites. 

The parts kit order number is 8002-9193 

The ECN information (ECN-0193.pdf) can be found on the Avolites website 

support pages or the Titan Version 6 landing webpage: 

www.avolites.com/V6Upgrade 

 

Once the ECN has been applied mark this process as done by selecting one 

drive type in the Process checklist above 

This concludes section 10. Follow the Process Checklist. 

 

11. ECN-194 Pearl Expert SSD DVD  

Pearl Expert consoles with serial number 1445 to 1650 will need the SATA 

CD drive cable removed. 

The ECN information (ECN-0194.pdf) can be found on the Avolites website 

support pages or the Titan Version 6 landing webpage: 

www.avolites.com/V6Upgrade 

Once the ECN has been applied mark ark this process as done by selecting 

one drive type in the Process checklist above 

This concludes section 11. Follow the Process Checklist. 

http://www.avolites.com/V6Upgrade
http://www.avolites.com/V6Upgrade
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12. Creating a Recovery Stick 

12.1 Which USB stick to use.  

Tiger Touch and recent Pearl Expert consoles will have a USB recovery stick fitted 
inside. When updating to V6 you can use this stick from the console, however 
doing so will prevent you from going back to V5.  

If you think there may be a need to go back to V5 then use a new USB stick. 

It is important to leave the recovery stick that was used to update inside the 
console. The reason for this is that you will have tested the USB stick and its 
content. 

The safest option is to fit both the original V5 and the new V6 stick inside the 
console. 

Note: If you decide to re-use the original stick (V5 or earlier),then delete the files 
before installing V6 recovery on it.   

12.2 Creating the Titan V6 recovery stick  

The recovery stick is dependent on the console, therefore download the correct 
recovery creator form the Avolites website 

A- Insert the blank USB stick in your PC or Laptop 

B- Double click on the downloaded “recovery stick creator.exe” file, This 

will open a new window with a brief copy of these instructions.  

Note: If the PC that you use is not running Vista or Windows 7 you will have to 
make the stick bootable. The Installer will guide you on this by clicking the 
“how to make a USB bootable..” link on the application. 

Note: Windows may warn you about running the application from a compressed 
folder, select “Run” to continue. You may also get a “Unknown Publisher” 
warning, select “Yes” in this case 

C- Click on “Next” in the Avolites application  

D- Select the USB stick from the  Drives pull down menu 

E- Click on “Install” , A new window with a progress bar is shown during 

the creation of the stick data, a second window will appear that creates 

the environment on USB stick, No user action is required on this 

window. 

F- Click on “Next” in the Avolites application once upgrade stick creation is 

finished this will show a brief instruction on the firmware upgrade 

process.  

G- Click on “Close” to end the Avolites application and automatically eject 

the USB stick. 

H- Remove the USB stick from the PC. 

Note: We strongly advice you to make a stick for every console and use that 
stick to update the console with and to leave it in the console as recovery stick. 
This assures you that if a recovery is needed at a later date it will work. 
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12.3 Installing Titan Version 6 

The following actions are performed on the console. 

1. Connect the USB stick in one of the USB ports at the back of the 

Console. 

2. Plug in the External VGA screen 

3. Plug in an external keyboard (Tiger Touch and Expert ShowSafe only) 

4. Start-up the console AND press the [Delete] on the keyboard to enter 

the BIOS.  

5. When prompted, type in the password “68340” followed by [Enter], to 

access the BIOS.  

6. Once in the BIOS, use the arrow keys to select the “Advanced BIOS 

Features” menu and [Enter] to open this. 

7. Check that the “First Boot Device” is set to “USB Device” use the  

8. Press the [F10] then [Y] to save the changes and then [Enter].  

9. When the console restarts it will boot automatically into the memory 

stick which will install the Titan V6 software. 

10. Accept the license agreement (scroll down to activate the agree button) 

11. Type in the serial number of the consoles when prompted 

12. Remove the stick when prompted, 

13. The console will restart and fail on “Disk Boot failure” this is intentional, 

power down the console using the front power button. 

14. Start-up the console AND press the [Delete] on the keyboard to enter 

the BIOS.  

15. When prompted, type in the password “68340” followed by [Enter], to 

access the BIOS.  

16. Once in the BIOS, use the arrow keys to select the “Advanced BIOS 

Features” menu and [Enter] to open this. 

17. Check that the “First Boot Device” is set to “Hard Disk” use the  

18. Press the [F10] then [Y] to save the changes and then [Enter].  

19. Once Titan V6 is up (either with the normal screen layout or with the 

HealthCheck  window  shut down the console  

20. Expert consoles only:  

In order to train the external screen orientation it is necessary to boot 

the Pearl Expert without a screen attached and then attaching the 

screen once booted, you will notice that the screen is upside down. At 

this stage press the following 4 keys on the keyboard at the same 

time: [ctrl], [alt], [shift] and [esc]. This will set the screen properly. 

Mark this process as done by selecting one drive type in the Process 

checklist above 

 

This concludes section 12. Follow the Process Checklist. 
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13. HealthCheck 

HealthCheck is a new utility which is run every time the console is started but will 
only be displayed if an action is required. 

The application checks various firmware versions to make sure that the console is 
compatible and reliable to use.  

A console that is up to date will not show the screen, a console that is not up to 
date will show the screen similar to the one below 

 

This one shows that the OCZ firmware needs updating. 

You will always have the option of fixing a problem or continuing to use the 
console. HealthCheck gives an indication of how long a fix may take. Obviously 
ignoring HealthCheck has may reduce the stability of the console, however if you 
are about to start a show this may be preferable to fixing at that moment in time. 

13.1 Intel 320SSD fitted 

Consoles fitted with the Intel 320 may need a firmware update, if this is required  

(Red Cross next to the Intel drive name) click on “FIX” and the Titan HealthCheck 
will update it for you. 

 

Mark this process as done by selecting one drive type in the Process 

checklist above 

 

This concludes section 13. Follow the Process Checklist. 
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14. Internal Recovery stick 

The recovery stick that was used to update the console should be fixed inside the 
console.  

Depending on your choice either re-fit the existing recovery back or fit a new one. 
Make sure the recovery stick cannot come loose and block the CPU fan or Pearl 
Expert drawer. 

And finally… 

14.1 Closing the Tiger Touch 

Close the console, and fix using the 3 screws at the front edge of the console 

14.2 Closing the Pearl Expert 

Close the console, and fix using the 4 quarter turn screws around the front. 

 

This nearly concludes the full Titan V6 upgrade, Thanks and congratulations from 
the Avolites team…. 

 

Mark this process as done by selecting one drive type in the Process 

checklist above 

 

This concludes section 14. Follow the Process Checklist. 
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15. Things that can go wrong 

This update is far reaching and requires many steps to be followed precisely; it is 
therefore possible to make a small mistake. Below is a list of problems and their 
likely cause 

Pearl Expert or 
external USB 
keyboard 

After the BIOS upgrade the keyboard stops working when not in 
the BIOS 

Cause:  USB keyboard support not set in the BIOS 

Resolution BIOS “Integrated Peripherals” Menu, then enter the “Onboard 

Device” Menu. Set the “USB Keyboard Support” to: Enabled, 

 

Stick not 
booting 

BIOS, firmware or V6 stick not booting 

Cause:  Removed the stick without ejecting  

BIOS first boot device not set to USB device 

USB stick can not be made bootable 

USB stick removed before ejecting it 

Resolution Remake the USB stick 

Press Exit then Select “Advanced BIOS features”  

Set the “First Boot Device” to: USB Device 

Find other brand/type of USB stick 

Properly eject the USB stick in windows  
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Appendix 1:   

Navigating the BIOS menu on a Tiger touch 

For the BIOS update we recommend using an external keyboard, but it is possible 
to use the program panel buttons to emulate a keyboard as shown below. 
 

 

 

Whilst performing this update 
the four grey buttons below the 
keypad will be used as Left, Up, 
Down, and Right buttons  

On the current desks these 
buttons are called [Bkspace], 
[Thro], [And] and [@ redo]. 

Use [Record Cue] for Yes.  
[Copy/Move/Link] for PgUp . 
[Speed] button for F10. 

For the Disk update software the 
external keyboard is required, 
this will be made clear in the 
instructions below 

 

Appendix 2:  

Navigating the BIOS menu on a Pearl Expert console  

The Pearl Expert has a conventional keyboard in a drawer at the right front 

of the desk, use this to navigate the BIOS and Firmware upgrade software 

Appendix 3: 

Floppy Disk BIOS upgrade procedure. 

For use when the console cannot upgrade the BIOS because there is no 

USB memory stick boot option. 

In this instance a floppy disk must be used to upgrade the BIOS. 

You will require: 

 The console requiring the upgrade 

 A blank floppy disk (or floppy disk that can be reformatted) 

 The USB memory stick containing the BIOS upgrader 

 A USB or PS2 keyboard and mouse 

 

1. Follow the instructions in section 4.1 (Creating BIOS bootable USB 

stick) to create a USB Bios upgrade memory stick 



 

 
 Titan V6 Full Upgrade Guide   V1.6   August 7th 2012               - 23 - 

 

2. Turn on the console 

3. Press the [Delete] button 

4. Enter the Bios password (68340) 

5. In “Standard CMOS Settings” set Drive A to “1.44Mb 3.25in” 

6. Press [F10] to save the Bios settings 

7. Put the blank floppy disk into the floppy disk drive  

8. Once the console has select the “Tools” menu 

9. From the “Tools” menu select “Folders”, and then select “Computer” 

10. You should be presented with a list of drives present, which will include 

the A drive 

11. Right click on the 3.25 inch floppy and from the menu select “Format” 

12. From the Format menu, tick the option at the bottom to create an MS 

DOS startup disk 

13. Select “Start” 

The floppy disk will now be formatted as a Boot Startup disk 

14. Once formatting has completed connect the USB stick containing the 

BIOS upgrade into the console 

15. Browse the this USB stick and copy to the A drive the files 

“67721T6.DAT” and “AWDFLASH.EXE” 

You now have a bootable floppy disk containing the BIOS upgrade information 

16. Leave the floppy disk in the console and restart the console 

17. Press the [DELETE] button on the keyboard to enter the BIOS and enter 

the password (68340) 

18. From the “Advanced Chipset Menu” set the “First Boot Device” to 

“Floppy Disk” 

19. Press [F10] to save this and the console will restart, but booting from 

the floppy disk 

20. At the prompt type “AWDFLASH” and press enter 

21. You will then be prompted to enter a file name, type “67721T6.BIN” 

and press [Enter] 

22. After about 20 seconds the prompt will change to “Please Wait”, and the 

file will be read. This takes at least 90 seconds so be patient! 

23. When prompted to save the old BIOS enter [N] (there is not enough 

floppy disk space to save this) 

24. Then press [Y] to start programming. 

25. The upgrading process will be displayed on screen. 

26. The screen will confirm the upgrade has completed correctly, if any 

errors are reported then contact Avolites. 

27. Once the upgrade is complete remove the USB stick and remove the 

floppy disk 

28. Press [F1] to restart the console 

29. Now follow the instructions from section 4.3 (Configuring the new BIOS) 


